Seven Years Later: A Look Back

GIMP Tutorial: Engraved Text

Game Zone: Funklift

Tip Top Tips: A Simple HTTP Server

PCLinuxOS Family Member Spotlight: tuxlink

Filenames: What's In A Name?

Editing Your Vacation Photos With XnViewMP

Installing A Seeburg 1000 On PCLinuxOS

PCLinuxOS Recipe Corner

And more inside ...

Vacation Days
# Table Of Contents

3 From The Chief Editor's Desk  
4 Seven Years Later: A Look Back  
7 Screenshot Showcase  
8 ms_meme's Nook: Anytime  
9 Filenames: What's In A Name?  
12 Screenshot Showcase  
13 PCLinuxOS Recipe Corner  
14 GIMP Tutorial: Engraved Text  
15 Screenshot Showcase  
16 PCLinuxOS Family Member Spotlight: tuxlink  
21 Installing A Seeburg 1000 On PCLinuxOS  
24 Screenshot Showcase  
25 Game Zone: Funklift  
26 Screenshot Showcase  
27 Tip Top Tips: A Simple HTTP Server  
27 Screenshot Showcase  
28 Editing Your Vacation Photos With XnViewMP  
31 PCLinuxOS Bonus Recipe  
32 PCLinuxOS Puzzled Partitions  
35 More Screenshot Showcase
From The Chief Editor's Desk

OK. First things first. After seven years, “Welcome From The Chief Editor” is getting a bit threadbare and worn out. So, starting this month, I’m changing the title of my monthly welcome column to “From The Chief Editor’s Desk.” It’ll feature the same content, but just be called something different.

Deservedly, my son has benefited from two outings in the month of June, in our quest to fit some family time into our hectic schedule. Early in June, we went to see Thomas the Tank Engine and his best friend, Percy, at a special “Day Out With Thomas” that was sponsored by our local PBS station. There, he not only got to ride in an open air coach pulled by Thomas, he also got to meet Sir Topham Hatt (a.k.a. The Fat Controller). Later in the month, Ryan got to experience his first ever visit to the Kansas City Zoo. It didn’t matter to any of us that it was a 100° F (37.8° C) day with high humidity, least of all him. Mom and dad just periodically steered the animal viewing towards the occasional air conditioned building to recharge and escape the heat. He had a blast. The birds and the endangered animal themed carousel were his favorites.

Things on the PCLinuxOS front seem calm, as usual. Thanks to the dedication of Texstar and the packagers, PCLinuxOS just keeps on working and working and working, without fail. Updates are typically smooth as glass. Any glitches that do arise are dealt with swiftly.

To follow up on past columns, I still haven’t updated my PCLinuxOS installations to 64 bit. It is on my to-do list, but the recent hectic schedule just hasn’t allowed me sufficient time to address it. My 32 bit installations are purring along quite well, but will eventually have to be replaced to remain current and to insure security.

Until next month, I bid you peace, happiness, serenity and prosperity.

Hectic. That’s the one word that describes how things are for me at the moment. Between working at the hospital (and balancing out mine and my wife’s work schedules there), trying to find time for managing magazine tasks and business, making sure we fit some “family time” into the mix, working on the home remodeling project, household tasks like yard work and maintaining our small garden, seeking refuge from the oppressive heat, and weekly OB/Gyn visits, things are hectic.

PCLinuxOS Magazine

Disclaimer

1. All the contents of The PCLinuxOS Magazine are only for general information and/or use. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any specific advice or replies to queries in any part of the magazine is/are the person opinion of such experts/consultants/persons and are not subscribed to by The PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an “AS IS” basis, and all warranties, expressed or implied of any kind, regarding any matter pertaining to any information, advice or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable, at any time, for damages (including, but not limited to, without limitation, damages of any kind) arising in contract, tort or otherwise, from the use of or inability to use the magazine, or any of its contents, or from any action taken (or refrained from being taken) as a result of using the magazine or any such contents or for any failure of performance, error, omission, interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness, suitability, or applicability of the information to a particular situation. All trademarks are the property of their respective owners.

5. Certain links on the magazine lead to resources located on servers maintained by third parties over whom The PCLinuxOS Magazine has no control or connection, business or otherwise. These sites are external to The PCLinuxOS Magazine and by visiting these, you are doing so of your own accord and assume all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users. The PCLinuxOS Magazine accepts no responsibility for the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with respect to the subject matter hereof and supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.
Seven Years Later: A Look Back

by Paul Arnote (parnote)

Holy cow! Or I guess I should I say “Holy Dobie!” I can’t believe that seven (7) years have gone by with me sitting in the Chief Editor’s chair. I’m not complaining, but it was never supposed to be like this. After this much time, let me try to recall the events that led up to the past seven years. After all, every story has a beginning.

In May, 2009, a “special edition” of the magazine was released after complaints that a new copy of the magazine hadn’t been seen in four months. Historyb was the editor at that time, and he had transitioned the monthly magazine into a quarterly magazine. He claimed that there just wasn’t enough “stuff” to write about to maintain a monthly publication schedule. So, they gathered up all the articles they had held back or collected, coupled with some new ones about a new kernel release, and threw them all into a “special edition” of the magazine.

Around the same time, there was a mutiny of sorts going on among some of the powers that were maintaining PCLinuxOS. Texstar had taken a sabbatical for health reasons, and placed control and maintenance of PCLinuxOS into the hands of those he thought he could trust. The 2009 version of PCLinuxOS had just recently been released, and some of those who had worked on the 2009 release had tried to position themselves into positions of “power.” Some felt that they were trying to take PCLinuxOS over in Texstar’s absence. Feelings got hurt, things were said, so a group of them – quite a few of them developers and packagers with PCLinuxOS at the time – banded together to set off to create their own Linux distro (Unity Linux, which really never saw any true or sustainable success), leaving PCLinuxOS with an exceptionally small group of developers and packagers. However, a loyal core remained.

When the “special edition” was released, it was chock full of ads for TinyMe, which was a version of PCLinuxOS that focused on being very lean. It came in at around 300 MB for the entire ISO. It had also lost its “official” status as a PCLinuxOS version, for reasons that really don’t matter at this point. Texstar had asked historyb to replace the ads before releasing the magazine, but historyb refused to comply. Instead, he attempted to claim ownership of the magazine and shut it down, instead of simply replacing the ads.

As is often the case when a void is created, others stepped up to fill the development and packaging shoes. In the case of the magazine, Archie Arevalo (you know him as one of the forum’s global moderators, Archie), undertook the task of revitalizing the magazine. Having a background in journalism (I was a newspaper photographer for over 10 years before changing professions to work in healthcare), I joined in on the planning. Together, we worked to put out the “NEW” PCLinuxOS Magazine, with July 1, 2009 as our target. Along the way, we collaborated on designing a new masthead for the magazine (which has since been changed), a new layout for the magazine (which has undergone a couple of further modifications), and laying out the guidelines for the magazine’s future.

In that issue, Archie announced that I would be assuming the role of Chief Editor of the magazine. He had discussed it with me a day or two before the release of the July 2009 issue. I distinctly remember discussing how long I would possibly continue as the magazine’s editor, and planning on doing it for a year or two, until someone else could be identified to take over the position.
Uhm ... that was seven years ago, and I am still here, putting out a monthly magazine.

The Journey

Over the years, I’ve overseen many changes in the magazine. Initially, Andrew Strick was named as the magazine’s assistant editor. And, Andrew laid out the August 2009 issue of the magazine – mostly, because I had ZERO experience with Scribus (used to produce the PDF version of the monthly magazine) and Andrew already had a pretty good grasp of Scribus. However, Andrew was in law school (he has since graduated and is working somewhere out in the wild legal world as an attorney), and as a result, he wasn’t as available as he had originally thought he would or could be. His participation was, understandably, intermittent.

When the September 2009 issue came due to assemble, I was pretty much on my own, trying to figure out and learn Scribus in the hardest way possible ... learn it by doing it. Andrew was too busy with school to be able to help much, with the new semester just getting started. To top it off, I did a lot of it in the hospital at my wife’s bedside, after she was hospitalized in late August of that year for about four days following a pretty nasty post surgical infection.

Today, I’m extremely proficient with Scribus. If you’re trying to learn Scribus, the best advice I can give you is to stick with it ... and make good use of layers. You will likely want to throw in the towel out of frustration, but stick with it. It becomes easier and easier the longer you use it. Plus, you’ll get much faster the more you use it.

Meemaw is the only holdover from the “old” days of the magazine, having worked on the magazine under former editors Tim Robinson, PapaWoob and historyb. She assumed a low profile during the turmoil, and resumed her assistance with the September 2009 issue. Since then, she has written many, many articles for the magazine. In August 2010, Meemaw was named a co-assistant editor, due to Andrew’s schedule being consumed by law school. By that time, Meemaw was not only writing articles, but assisting with the proofreading and editing of articles, as well as helping with the monthly magazine layout chores. She has been very involved in helping create the magazine’s covers since joining the revitalization of the magazine. Eventually, Andrew faded away due to the demands of school and starting a new career, and the “co” was dropped as Meemaw became THE assistant editor. Quite frankly, I don’t know how I’d be able to do all of this without her assistance.

Over the past seven years, I’ve witnessed many contributors come and go. Each, in their own way, has helped shape the magazine. At the risk of leaving someone out, I’d like to thank those who, in the past, have helped shape the magazine. If I’ve left anyone out, I offer my apologies. So, a sincere thank you to Macedonio Fernandez, David Lally, Mark Szorady (georgetoon), Sproogy, Hootiegibbon, Malcolm Ripley (malc), Darrel Johnston, daniel (a.k.a. leiche), Not Yet_16, BigBearOmaha, Don Cristi, Andrew Strick (stricktoo), Archie, Joble, Andrew Huff, Patrick Horneker, galen, Timeth, Andrzejs, maik3531, pinoc, Slavisa Milojkovic, Gary L. Ratliff, Sr. (eronestuc), csolis, Bob Krausen, Rudge, Efstatios Iosifidis (diamond_gr), Jim Wilkinson (jimwilk), Grandpa, cstrike77, longtom, Antonis Komis (agmg) and loudog. There have been many contributors to the magazine over the past seven years, and I want to thank each and every one of you. Again, I apologize if you weren’t named in the aforementioned list, but every contributor has placed their own indelible mark on the magazine, and helped to make it what it is today.

I’ve also witnessed several “regular” columns come and go. In the past, we’ve had Mark’s Gimp Tips & Double Take, Forum Foibles, ms_memes monthly calendar, Repo Spotlight, Wiki Wicket, alternate free operating systems, and Scripts R Us, to name a few. I’ve overseen the birth and growth of some magazine regular features, such as Screenshot Showcase, ms_memes Nook, PCLinuxOS Puzzled Partitions, and the monthly graphics tutorials that alternate between how to use Gimp and Inkscape. We’ve run many article “series” covering all of the major desktop choices in PCLinuxOS, LibreOffice, video tools,
Firefox add-ons, computer and internet security, money manager/financial programs, and personal information managers ... among others.

Some of our article “series” have given birth to “special editions” of the magazine. The special editions of the magazine were conceived to act as an additional reference resource for PCLinuxOS users. Our first special edition was a gathering of all of the articles covering KDE 4. That was followed by the Command Line Interface Intro special edition, with all of critter’s excellent articles on how to learn the command line. We then combined all of the Xfce and LXDE desktop articles into the Gtk Lightweight Desktops special edition. Next came the Enlightenment desktop special edition, followed by our Scribus special edition. The Openbox special edition came next, followed by the Gnome 2.32 special edition. When Windows 8 came out, we came out with our Windows Migration Guide to assist users in migrating from the failed Windows interface to PCLinuxOS. The Xfce Power User Tips, Tricks & Tweaks special edition was next. In the very near future, be on the lookout for additional special editions, including collections of the graphic tutorial series.

The road ahead

There’s a lot I could talk about here, but I’ll save it for another time. There is, after all, another milestone rapidly coming up for The PCLinuxOS Magazine. On a personal note, I am not planning on going anywhere. Even though my original intent was to hold the Chief Editor position for only a year or two, and even though I had at one time REALLY wanted to learn how to package RPMs for PCLinuxOS (managing the magazine doesn’t leave a lot of extra time for such pursuits), I plan to keep on heading up the production of the magazine every month.

In seven years, a lot can change. Indeed, I’ve seen a lot of change, both with the magazine itself, and in my personal life. The latter has had the most impact. My son was born nearly three years ago, and our second child is due in a couple of months. All that “free time” I had when I started in this position isn’t quite so “free” any longer. Finding the time to work on magazine articles, managing the magazine’s website, laying out articles and assembling the magazine PDF, and performing other magazine business is getting more challenging. It forces me to get more creative in looking for opportunities to make time available.

Probably the most challenging aspect of this position is getting individuals to contribute to the magazine – preferably on a regular basis. But even an occasional article every now and then helps. No one working on the magazine is paid. Our compensation is the satisfaction of giving something back to the PCLinuxOS community. As such, we are a community magazine – of the community, by the community, for the community. We need contributions from the community in order to thrive. Neither I, nor Meemaw, can possibly think of everything that needs to be covered. Every user has a unique perspective and an equally unique approach to solving problems, and it’s in the best interest of the community to capture as much of that uniqueness as possible. This has been the longest running – and most frustrating – part of this position. It’s one thing that me and Meemaw struggle with continually.

I remember asking Meemaw some time ago if she was interested in moving into the Chief Editor’s chair. Her answer was quick, brief, and succinct: no way, no how. No one else has emerged as a possible successor, and no one appears to be on the horizon or radar. But then, I really wasn’t “on the radar” when I got this position, either. Up until the time that I assumed the editor’s role for the magazine, I had only written a couple of articles that ran in the magazine. I was an “occasional” contributor. As such, I plan to remain in this position for the foreseeable future. I’d really hate to see that which we’ve worked so hard to create and maintain, disappear.

I only hope that we’ve been able to produce a magazine over the past seven years that the PCLinuxOS community is proud of. I know that Meemaw and I are proud of the work that we’ve done. But our personal opinions are just that – opinions. For us, what really matters is how the community feels. Even though The PCLinuxOS Magazine is read by users outside of PCLinuxOS, it’s the PCLinuxOS community’s opinion that matters the most to us. Gauging by the comments in the PCLinuxOS forum, I believe that we have succeeded.

Today, we have the longest, continually published community Linux magazine in existence. Our goal is to keep the PCLinuxOS community proud – and informed.
Screenshot Showcase

Available in the following desktops:
- KDE
- LXDE
- Xfce
- Openbox
- Gnome
- Enlightenment e17

Posted by chilly, on June 3, 2016, running KDE.
ms_meme's Nook: Anytime

Anytime you need a distro
Anytime you've work to do
Anytime you need plain or fancy
PCLOS is for you

Don't make no dif if you're a newbie
Or a master of the shell
So come on home to PCLOS
You will find it does it all so well

Anytime you want perfection
Anytime you want the ideal
Anytime you want the best distro
PCLOS is a great deal

Don't fool around with all the others
Say to them a fond farewell
So come on home to PCLOS
You will find it does it all so well

Anytime you're feeling lonely
Anytime you're feeling blue
Just get yourself to the PCLOS Forum
Always something new for you to do

Anytime you're thinking 'bout fun
Come on in for it's all free
So welcome home to PCLOS
The Forum's the place where you should be
FileNames: What's In A Name?

by Paul Arnote (parnote)

We've all seen them. We've all encountered them, at some point in our computing history. That dreaded, pesky file that resists deletion, or that is difficult to deal with.

This becomes especially troublesome when you share files with Windows, Mac and Linux users. Each platform has its own separate rules regarding what characters are allowed in filenames. What might be perfectly acceptable on one platform for filenames may be verboten on another.

So, let's take a look at how to deal with these pesky files and filenames.

Grasping the basics

The “basics” vary, depending on the platform you are using. To better understand those basic rules, you have to understand the ASCII tables.

You are going to find Windows filename restrictions to be the most numerous. Let's start with it first, since there is a good chance of you having to share files with Windows users.

First, any ASCII character appearing between 0 and 31 (decimal value) is forbidden. Then, all of the following characters are also disallowed:

< (less than) > (greater than) : (colon) " (double quote) / (forward slash) \ (backslash)

| () (vertical bar or pipe) | ? (question mark) | * (asterisk) |

As if that wasn't enough, certain keywords are reserved for exclusive use by Windows, and are thus not allowed to be used for filenames:

CON, PRN, AUX, CLOCKS, NUL
COM1, COM2, COM3, COM4

LPT1, LPT2, LPT3, LPT4 (LPT4 only in some versions of DR-DOS)
LST (only in 86-DOS and DOS 1.xx)
KEYBD$, SCREEN$ (only in multitasking MS-DOS 4.0)
$IDLES (only in Concurrent DOS 386, Multiuser DOS and DR DOS 5.0 and higher)
CONFIG$ (only in MS-DOS 7.0-8.0)

Full ASCII Table.

Source: www.LookupTables.com
Filenames: What's In A Name?

- [0-9a-zA-Z_] - Alphanumeric characters and the underscore are always fine to use.
- `\`: `*?<>|` and the null byte are problematic on at least one system, and should always be avoided.
- **Spaces** are used as argument separators on many systems, so filenames with spaces should be avoided when possible.
- **Colons (:)** are used to separate commands on many systems.
- `[]()` `^` `%` `&` `@` `:` `+` `=` `\` `~` `` all have special meanings in many shells, and are annoying to work around, and so should be avoided. They also tend to look horrible in URLs.
- **Leading characters to avoid:** Many command line programs use the hyphen `[.]` to indicate special arguments, while *nix based systems use a full-stop `[.]` as a leading character for hidden files and directories.
- Anything not in the **ASCII character set** can cause problems on older or more basic systems (e.g. some embedded systems), and should be used with care.

That basically leaves you with [0-9a-zA-Z-.] that are always safe and not annoying to use (as long as you start the filename with an alpha-numeric).

**Dealing with troublesome filenames on Linux**

Even though Linux filesystems allow the use of all characters except NUL and `/`, that doesn’t mean that there aren’t characters that can make life uncomfortable and troublesome when dealing with filenames that use those certain characters. Regardless of whether you love or hate the command line, and regardless if you avoid the command line like the bubonic plague or embrace all of its power, all of us will find ourselves using it at some point or another. As such, it’s important to

And, if those weren’t enough, the NTFS file system further restricts the use of additional filenames, because they are used internally by the NTFS file system.

`$Mft`, `$MftMirr`, `$LogFile`, `$Volume`, `$AttrDef`, `$Bitmap`, `$Boot`, `$BadClus`, `$Secure`, `$Upcase`, `$Extend`, `$Quota`, `$ObjId`, and `$Reparse`

It’s enough to make you question why Windows remains so popular among the general computing public, huh?

On Linux systems, only two characters are disallowed: **NUL** (ASCII decimal code 0) and the `/` (forward slash, ASCII decimal code 47). Even though all the other characters are allowed, the use of certain characters may cause you problems in the long run. We’ll talk about them later.

On a Mac system, only the : (colon, ASCII decimal code 58) is disallowed from use in filenames.

I can’t help but reiterate that all of this becomes vitally important when you are creating files that might be used or viewed by users of the “other” systems. Use a wrong character (or reserved keyword or internal filename), and the user of the other system won’t be able to access your file.

**Making safe choices**

If you want to guarantee cross-platform accessibility to your files, below is a set of “rules” to follow.

![Extended ASCII Table](source: www.LookupTables.com)
Filenames: What's In A Name?

On the command line, the dash character *denotes* a command line option or switch. When a dash is the first character of a filename, your command line shell will interpret what follows the dash as a command line option or switch. When it doesn’t match up with any known option, the command will fail, as in the example above.

To resolve this issue, you have two choices. First, precede the filename with two dashes, like this: `nano -- -myfile.txt`. Alternatively, you can simply precede the filename with `/` to denote that the file is within the current working directory: `nano ./myfile.txt`. If the hash/pound sign is at the beginning (`#myfile.txt`), everything after the `#` is seen as a comment. If the hash/pound sign occurs elsewhere in the filename (`my#file.txt`), everything after the hash/pound sign (`"my"`) is seen as a comment. In either case, the file won’t be found.

There are two solutions. First, and just as we did with the dash as the first character, you can precede the filename with `.` to denote that the file is in the current working directory: `nano ./myfile.txt`. Alternatively, you can enclose the filename in single quotes, like this: `nano '/myfile.txt'`.

Filenames with a semicolon (;). These filenames can also be problematic. Under BASH (and probably other command line shells, too), the semicolon is used to chain multiple commands together. So, when there’s a semicolon in your filename, it sees everything after the semicolon as the start of a new command. It also prevents the file from being found, due to the misinterpretation.

Fortunately, the way to work around this issue is the same as with the hash/pound sign that we discussed previously. Thus, you can either put a `.` in front of the filename (`nano ./myfile.txt`), or enclose it in single quotes (`nano '\myfile.txt'`).

Just add single quotes. With certain other “special” characters used in filenames, all you have to do is enclose the filename in single quotes. Those characters are `$`, `!`, `@`, `&`, `{}`, `^`, `<>`, and `\`.

As a side note, if you need to use/work with a filename with a single quote in it, enclose the filename in double quotes.

No special action needed. With other “special” characters that might appear in filenames, there is no special action necessary under Linux. Those characters are `+`, `%`, `*`, `^`, `{}`, `[`, `]`, `,`, `=`, `?`, `::`, `~` and `..`. You can use/work with files containing these characters in the filename just as you would any other file.

Summary

Whether you follow the rules for filenames or not, you will eventually encounter files that are difficult to deal with. In fact, you probably already have. Knowing the rules arms you with the knowledge to properly deal with them. Meanwhile, you can also avoid these pitfalls by avoiding their use in your own files, and make life simpler for those with whom you might possibly share those files.
**Salsa Shrimp Tacos**

**Ingredients**
- 3/4 cup Thick ‘n Chunky salsa
- 1/2 cup frozen chopped green bell pepper
- 3/4 lb uncooked deveined peeled medium shrimp, thawed if frozen, tail shells removed
- 1 box (4.6 oz) taco shells (12 shells)
- 3/4 cup shredded Mexican cheese blend (3 oz)
- 3/4 cup shredded lettuce
- 1/4 cup your favorite taco sauce

**Directions**
1. In 10-inch nonstick skillet, heat salsa and bell pepper over medium-high heat, stirring frequently, until warm.
2. Stir in shrimp. Cook 3 to 4 minutes, turning shrimp occasionally, until shrimp are pink.
3. Fill each taco shell with about 1/4 cup shrimp mixture. Top with cheese, lettuce and taco sauce.

---

**Want To Help?**

Would you like to help with the PCLinuxOS Magazine? Opportunities abound. So get involved!

You can write articles, help edit articles, serve as a “technical advisor” to insure articles are correct, create artwork, or help with the magazine’s layout.

Join us on our Google Group mailing list.

---

**Does your computer run slow?**

Are you tired of all the "Blue Screens of Death" computer crashes?

Are viruses, adware, malware & spyware slowing you down?

Get your PC back to good health TODAY!

Get

**The PCLinuxOS Magazine**

Created with **Scribus**

Download your copy today! FREE!
GIMP Tutorial: Engraved Text

By Meemaw

I found another fun text effect to show you. This effect makes your text look like it has been cut or burned into the background.

Load in whatever image you want to use. I am using a couple of different wood images. Place your text on the image. Move the text layer to where you want it, then choose Layer > Layer to Image Size. Also, choose the image you imported and choose Layer > Layer to Image Size again. This will make sure the changes we make will work correctly. We are going to use the Displacement tool to roughen up the edges of our text, so it looks like it follows the contour of the wood. To use that filter, both layers have to be the same size.

With the text layer chosen, click on Filters > Map > Displace. In the window that appears, choose the wooden background in both boxes, and leave the other settings at default, then press OK. Now it should look like it has picked up the texture of the background.

Select the text layer, right-click it and choose Alpha to Selection to outline your roughened-up text. At this point you can delete the text layer, and we'll work with just the selection. Now we want a drop shadow, but sort of inside the text so it looks cut in rather than popped out, like we did in March. To do that, we will first invert the selection, then choose Filters > Light & Shadow > Drop Shadow. Leave most of the default settings, but change the Opacity to 100%. Now you can see a shadow inside the text that is starting to make it look engraved.

However, we need another drop shadow with different settings. Choose Filters > Reshow Drop Shadow (because the Filters menu saves our work as well), then change the settings to X = 0, Y = 0, and Blur Radius = 30. This puts a bit more shadow where the first one was, plus adds some to the other side of each letter.

Now you can click Select > None to remove the selection lines.
Save your work, if you haven't already, then crop your image and export it as your desired image file.
As told to YouCanToo

What is your name/username?

Hi, my name is Michael Duffy, my username is tuxlink. I was born and raised in Dublin, Ireland. In the late 1980’s, I literally won the opportunity to go live and work in the United States of America. In 2005, I became a Naturalized Citizen of the United States. I now live on the outskirts of Los Angeles, California. The epic saga of how I got from there to here could fill volumes, and some day I intend to have that tale on sale at Amazon.com for at least $29.99. For at least the first volume, anyway!

How old are you?

By the time you read this, I will have grown and shaved many beards! Many moons will have risen and fallen, time means different things to different people, but the voices in my head tell me the magic number is.................42. “No, that’s not what we said!” “You wish it was 42, but you were just looking for a line to use Douglas Adams answer to the question of what is the meaning of Life, the Universe and Everything, from his wonderful book ‘The Hitchhiker’s Guide to the Galaxy’,” “Be brave, say it with us……Fifty…….” “One!” “No,,,” “Two!…..” “Michael…!” “Fine……I’m (…mumbles under breath…)” “Out loud please!” “FIFTY SIX!!”

Are you married, single?

Funny story, that. I was at a party one time and there was this beautiful girl with a cheerful hearty laugh with a red sweater and gorgeous red lips. All I could think about was kissing those lovely red lips, and since it was St. Patrick’s Day, we Irish have been accused of being a little more ...cheerful, and ...friendly, and have a tendency to lose all our inhibitions about kissing girls in red sweaters with gorgeous red lips on that particular day of the year. Being the only person with a thick Irish accent who knew a little guitar and the words to a few Christy Moore songs and being very far from home, as luck would have it, Red Lips in the red sweater was mightily impressed!

By the time I woke up from the effects of that party, I was changing the diaper of our second child, a lovely daughter, and driving a used Chevy Astro Van! Gorgeous girl with the red lips in the red sweater and I have been married now for 25 years.

How about Kids, Grandkids?

The two I am aware of and admit to are Michael, a son aged 21 yrs, and Shannon, a daughter aged 19 yrs.

Do you have pets, what is your favorite?

We are the proud owners of a Goldfish whom we have named, I kid you not, ‘The Whale’. When my daughter was much younger (8 yrs old) she begged us for a puppy, we said no! She begged us for a pony, and still we said no! One time as we watched PBS’s ‘Nature’ there was a litter of cute Lion cubs, my daughter shot me a look and held out her hands, I gave her the thumbs down signal and silently mouthed the word No!

Then one day she won a ticket at a Fair for one fish from a local pet store. What could I do, this kid had worn me down over time and swore she'd take care of all it's needs. One trip to the pet store, and most of that month's paycheck (sure felt like it anyway!) and we were setting up a new tank, treating the water, setting the plastic plants around the Treasure Chest and the underwater Greek ruins statue. “The Goldfish would be terribly lonely if we took him away from his family at the store,” she pleaded! So, other fish were purchased to keep him company. My daughter dutifully fed and spoke to her new pal in the tank......for about two weeks!

The Goldfish grew, as they all do, what we didn’t expect was after he got over his loneliness, he got hungry, and decided to eat those that were purchased to keep him company! He doubled in size again now being too big for his tank! “This was cruel and unusual punishment”, my daughter protested, “Eh hello”, I said, “I’m sure his companions aren’t too happy either!” In time, we needed a bigger tank. By now, my darling daughter had moved on to a Hamster. Her new pet. She constantly corrected me as I yelled for her to come scoop up her Rat and get
As a kid growing up in Dublin, the constant rain and bitter cold of Winter that sometimes lasted far into what they politely call Summer back there, was just too much for me to bear. As I cycled to work every morning back then, before I eventually dried out, I swore to myself if I ever got the chance to live somewhere where the sun shines more, and the rain, rains less, I'd jump that chance. I made it to New York and lived there for about 6-7 months. That was clearly 6-7 months too long! (No offence NY, but it’s not for everyone.) To make a long story short, like many others of my age, I felt the need to ‘Go West Young Man’. I partnered up with another Irishman on what could only be described as an adventure of a lifetime and drove west on Route 66 where we indeed found our kicks!

Because this area where we live is basically a desert, the extreme temps of Summer here can reach the other end of the weather spectrum, but so far I still like waking up and looking out at a sunny clear blue skied day most of the year! When it's that nice outside, your mood and your day can only get better! We’re very lucky as where we live has a large lake and a big open wild field behind our home. I am an avid photographer and have been lucky enough to capture just some of what lives locally. We are constantly visited by all forms of wildlife here on a daily basis. Lots of coyotes, hawks, skunks, snakes, owls, ducks, hummingbirds, buzzards, rabbits, lizards and lately two squirrels living in the tree that overhangs our garden wall!

One morning a few years ago, I arrived out to my car in the driveway to leave for work at 6 am. I was greeted with what looked like a scene from a horror movie! There on the roof of my car was the remains and the last leg of a rabbit! Blood all over the roof and running down the rear window. (We figured) a crafty owl had caught a rabbit during the night, and had dragged it up onto my car’s roof so as no other creature could reach it and steal it away! So you see, even the wildlife here are obviously happy and above average intelligence!

**PCLinuxOS Family Member Spotlight: tuxlink**

**Are you retired, still working and what do you do?**

I have had many positions of work, as they were called. Many of the first you can read about in the early chapters of the aforementioned book on Amazon, but for the last 22 years I have been a Letter Carrier for the United States Postal Service here in Southern California. Due to ill health I have had to retire. I enjoyed the work very much, the dogs, the crazy people, the weather, every day brought a new story much of which could yet again fill volumes of books. I’m thinking I should find me a publisher!

**Where do you call home? What is it like? IE: Weather, scenery etc...**

Here in Southern California the good weather is the biggest draw for many, and unfortunately that means a large dense population. Most people living here don’t like the large crowds, but I have become used to it and just see it as part of living somewhere warm and dry.
PCLinuxOS Family Member Spotlight: tuxlink

Where did you go to school and what is your education level?

Back in Dublin I went through the usual Catholic driven public school system. I did finish up to the level of High School and then started to work. When I got to California I took some classes in our local community college. Constantly working and starting a family, I never got back to it. I feel over the years the experience I have gained through travel and settling far from where I grew up has paid dividends and afforded my family and I the opportunity to be not necessarily wealthy, but certainly happy and content.

What kind of things do you like doing? Hobbies, travel, fishing, camping?

As I stated earlier, I am an avid photographer and love the opportunity to shoot different subjects and scenes. While living back in Ireland I was a member of a wonderful Photographic Society and it gave me a wonderful appreciation of all the many great things there are in life that need to be photographed. I enjoy nothing better than finding a great opportunity to shoot something I have not shot before and then work on it to enhance and improve it with all of the many great open source photographic tools we now have available to us through Linux. Have you used Gimp yet to work on your photos? If not, you’re missing an awful lot. Not to mention DigiKam, Hugin, Gwenview etc...the list goes on and on. It’s a great time to be a photographer and use PCLinuxOS as your OS right now. I noticed we also have a new application in the PCLOS 64bit repos called Lightzone. On first examination of this app, I am really looking forward to using this a lot more in the near future. It looks like it has a lot of potential for photographers of all levels to use and work with.

Of late, I have begun to enjoy building a World War 1 model plane I received as a gift. I was always a fan of woodworking and have some tools which I love working with. I tend to stick with small projects like boxes and Intarsia items. One small project I enjoyed was a wooden passive amplifier for a modern cell phone. I custom made it to fit my phone and lo and behold, it actually made the audio speaker sound a little better!

Other than that, I always enjoy checking into the PCLinuxOS forum on a daily basis. Over the past year or so, I have made some new friends here and enjoy chatting in the PCLOS Chat-server in the #chimpbox room. If you’re at all curious, don’t be shy, we’re all very friendly, come join us, we talk about all kinds of stuff every day. By the way, if there’s no one there the day you drop in, check back the next day, I know I log in almost every day. You never know, you might be there when the next big idea starts to sprout.

Did you know it was right here in the PCLOS Chat-server that the current popular line of low power, small sized, fanless line of computers called ChimpBoxes, were first conceptualized? At first it was just a collection of ideas being thrown out into the room by a few individuals. The subject of conversation that night was about the Linuxmint’s Mintbox. We all felt that we already used the best OS in the world (PCLOS) and certainly the hardware of the Mintbox was not exactly something to brag
about, so after many suggestions from many corners of the world, and countless searches for better hardware, MrCrankyPants_YouCanToo was the brave soul that collected all the ideas and actually put the work into creating the first prototype and magically somehow made all of our far fetched ideas into reality. Having yours, mine and everyone’s favorite monkey in the room that night, Mr joechimp, I suggested with his blessing, that we name the box ‘The ChimpBox’! Mr joe was graciously honored, and frankly so was I when I was able to get my hands on ChimpBox #2. It has been the most fun I have ever had using a computer compared to all the hardware from my past. I even got the chance to create some ‘Chimp’ themed wallpapers for the official release of the software that arrives with every box that is sold. It was fun and exciting to have been there at the very beginning and see it all unfold into the successful product that is being shipped to all corners of the world right now. Feel like being a part of history? Then come join us in the PCLOS Chat-server any day or night of the week. You never know, maybe your unique idea will start the next process that will snowball it’s way into history.

So for me, I feel it is not so important what I have used in the past. When I say not so important, I mean in terms of good reading, but for the record, it was an old used IBM XT with a CGA monitor. It worked, I broke it and got into trouble with the wife, and had to fix it! (I know, I came late to the game!) To directly answer the question, I have been a distro hopper for a number of years, since back in the early 90’s. At first I was a Microsoft DOS/Windows user like most. As bad as that was back then, as soon as I discovered Linux, I could no longer see the need to pay out what MS Windows cost and after Windows XP, I bid it all a fond farewell and haven’t looked back since.

While I was working, I wasn’t in a position to get deeply involved with any one distro or it’s community. But now that I have retired I have decided on the last and final distro I will ever need, and that’s easily the best there is, PCLinuxOS!

What I think about Linux and open source software is really more important for me. Early developers and code writers sat down upon seeing that computers needed to be available to not just the elite and wealthy few in the world, but available to all. In fact I’m sure those early programmers could not have even imagined what the use of a computer could have meant to so many in the future. That single act of writing code, and then deciding to give it away is
highly commendable. That very same unselfish act happens every day all over the world. It is that one concept of wanting to give back and pay something forward to others that makes me feel there is indeed still hope for us. I can't write code, but I have found some small ways to add and give back to the community we have here. I consider us all very lucky to be headed by someone as talented and giving as Texstar and the many others who have worked so hard to create what many of us enjoy. Linux to me is a huge gift, has made a big difference in my life and I am grateful for the efforts of those that were so unselfish to share it. If you feel like contributing, you can donate to PCLinuxOS or involve your talents to better the community in other ways. It's a win-win situation for everyone.

PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.

commandlinefu.com
Installing A Seeburg 1000 On PCLinuxOS

by phorneker

This is the first of a series of articles on background music implemented on PCLinuxOS. We shall start with the Seeburg 1000 Background Music System circa 1959.

The Seeburg 1000

In 1959, Seeburg Corporation, known for its jukeboxes (the most famous being the one featured in the opening of every episode of Happy Days back in the 1970s), came up with the idea of building a background music system the size of a microwave oven using a stack of records and a tonearm with styluses on both the top and bottom allowing for playback of records on both sides unattended. Theoretically, the system should be able to play 1000 songs without repeating any one selection from a stack of records (hence the name Seeburg 1000).

There are videos of this system in action. Just search seeburg 1000 on YouTube.

The magic behind the Seeburg 1000 is in the mechanism on how records are played. The Seeburg Music Library provides the content for the system in the form of a monthly subscription where a stack of seven records is sent to the customer (with instructions for the customer as the records are carefully ordered as to the sequence where the records are played), with the previous set being returned to Seeburg.

(Of course, not everyone followed those instructions...and thankfully so or we would not be able to access the Seeburg Music Library on the Internet.)

The customer opened the front of the Seeburg 1000, and inside is the turntable mechanism consisting of a tonearm, a platter and a spindle, all of special design to make the background music system work unattended. Also included are controls for volume, bass, treble and external microphone, and switches to power the device, as well as to start and stop playback of music.

The tonearm has styluses on the top and bottom allowing for playback of the records on both sides without having to flip the record over.

The spindle is a two part mechanism with the lower half rotating clockwise and the upper half rotating counter clockwise.

The stack of records is placed on the upper half of the spindle allowing for playback of the music starting with the bottom of the stack and the bottom side of the record played first. When that side is finished, the mechanism drops the bottom record halfway down the lower half of the spindle where the top side of the same record is then played.

When that side is finished, the record then drops to the platter and the tone arm starts playing the bottom side of the next record in the stack.

When all the records have played and dropped on to the platter, the mechanism of the platter then raises the platter until the records have reached the top half of the spindle. Once that has happened, the spindle locks the records in place, the platter is lowered to its original position, and the stack of records is then ready to be played again.

About the Records

The records that go into the Seeburg 1000 are nine inches in diameter with a two inch hole (slightly larger than typical 45 rpm records). The music is recorded at 16 ½ rpm with a 5mm stylus (as opposed to the standard 7mm stylus found on typical turntables). The records can be played on a standard turntable (there are plenty of YouTube videos demonstrating that), but it is not recommended that one should do so for any length
of time as the records will wear out faster with that kind of playback.

Records are labelled such that they present the order in which they are to be played in the Seeburg 1000.

The Seeburg Music Library

The Seeburg Music Library is the core component of the background music system and consists of three types of libraries, namely the Basic, Mood and Industrial. Seeburg Corporation employed their own orchestras for recording of the music, and the music is arranged, sequenced and programmed specifically for Seeburg, and its customers, so what the customer got on the Seeburg 1000 was tailored specifically for that customer's background music needs.

Basic: This is the medium tempo music consisting of instrumental covers of show tunes, top 40 (of that day), and standards. This library type was typically heard in shopping malls, department stores, restaurants, and offices. In the late 1970's, this type was renamed Lifestyle to reflect the changing of the times.

Mood: This is the medium-slow tempo music designed for upscale venues such as country clubs, high end department stores (such as Neiman Marcus and Tiffany's), and lounges. In the late 1970's, this was renamed Penthouse to reflect the changing customer base for this library.

Industrial: Designed to increase productivity, this library consists of medium-fast tempo music, and was also the most varied as to the types of music programmed for this library. In the late 1970s, this was renamed Upbeat for rather obvious reasons. Among the types of music include polkas, mariachi (with the obvious influence of Herb Alpert and the Tijuana Brass), instrumental disco, blues, and jazz. Some synthesizer music and vocals were included in this library.

Accessing the Seeburg Music Library

At http://seeburg1000.com, the entire Seeburg Music Library is available for your listening pleasure. You can use Clementine, Amarok, VLC or other media player available in the PCLinuxOS repository to access the library.

What we need to do is to download a playlist file containing the URL for the Seeburg Music Library. At this website, click on “Click to Play!” (the button with the microphone on it), and the following will appear on the next web page (image on next page).
Installing A Seeburg 1000 On PCLinuxOS

home account as you will want to configure other media players to use the Seeburg Music Library. Select “Save File” and click OK to download the file.

Alternately, if you prefer to use VLC, simply select Open with... with VLC selected, and click on OK. VLC will launch and the Seeburg 1000 will start playing.

The playlist.pls File

The playlist file is a text file consisting of six lines. Below is the contents of playlist.pls.

[playlist]
numberofentries=1
File1=http://50.7.96.210:8204/
Title1=Seeburg 1000
Length1=-1
version=2

Much of this should be self explanatory. Here, there is only one entry in this playlist, namely the Seeburg Music Library.

File1 contains the URL for the Seeburg Music Library hosted at streamlicensing.com, with the IP
address of **50.7.96.210** and using port **8204** for music distribution.

**Title1** is just what it says, the title of this playlist, namely *Seeburg 1000*.

**Length1** has a value of **-1** indicating that there is no finite length of the audio track, that is, this is an audio stream rather than a file.

Hence, we now have a URL for accessing the Seeburg Music Library, namely

http://50.7.96.210:8204/

In Clementine, go to **Playlist -> Add File** (or press Control-Shift-A on a keyboard), then select **playlist.pls** from the Downloads folder and click on OK.

Alternately, you can select **Internet** on the sidebar, right click on **Your Internet Streams**, then select **Add Stream...** from the popup menu. When the dialog box appears, type **http://50.7.96.210:8204/** for the URL and **Best of Seeburg 1000** for the description and click on OK. The link should appear under **Your Internet Streams**. Double click on the new link, and the Seeburg 1000 will start playing.

This technique will also work with Amarok, Audacious and aTunes, available in the PCLinuxOS repository.

Enjoy this blast from the past.
Game Zone: Funklift

by daiashi

About The Game

Ever wanted to fork your friends? Well you can't, that's disgusting. Instead, please enjoy a heartwarming game of Funklift, the only local multiplayer party game that features forklifts in a futuristic disco setting! Play alone or challenge your friends to a wild race for the highest score! Choose between free-for-all, teams or full cooperative mode.

History:
Funklift started out as a student project in a university course during the spring of 2015.

Features:
• Drive a forklift!
• Up to four players.
• A variety of funky levels
• But seriously, what other games have jumping forklifts?
• The missiles, rocket boosters and landmines are also pretty cool.
• I looked it up, they're called 'forklift operators'.

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:
Minimum:
OS: PCLinuxOS
Processor: 2 GHz Dual Core
Memory: 3 GB RAM
Graphics: 1 GB VRAM
Storage: 1 GB available space

Additional Notes: Gamepad required for multiplayer, and highly recommended for singleplayer

About The Company

Mostly Harmless Games is a small game development studio hidden in the mist shrouded mountains of western Sweden. Mostly, Harmless Games started out as a group of students randomly paired for a game project course at the University of Skövde in April 2015. The goal was to create a prototype for a local multiplayer party game with forklifts in under ten weeks. They named their team of developers after Douglas Adams masterpiece, "Mostly Harmless." Their little family of artists, programmers, designers, writers, musicians and audio engineers set about to create what would become a far more ambitious project.

Forming a Company

After the course was completed and the prototype finished, the majority of the team decided to take the project with the working title “Gaffeltruck” to a summer course, the joint initiative between the University and Microsoft Game Camp, where the entire summer developing a completely revamped iteration of the game. The game was eventually named "Funklift". After Microsoft Game Camp, most of the team split up and their family shrunk. Five of them remained. They decided to join a ten-week education in business development and entrepreneurship, finalized by a pitch before Gothia Science Park, who would later offer them a spot in their incubator. To this day, they enjoy their lives from the safety of their office cave.

Some Gameplay Screenshots
Getting It To Run

Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab and search for Funklift. Click on and download the demo. If you have updated your system, including graphics drivers, you should be good to go.
**Tip Top Tips: A Simple HTTP Server**

*Editor’s Note:* Tip Top Tips is a new monthly column in The PCLinuxOS Magazine. Each month, we will feature – and possibly even expand upon – one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum’s “Tips & Tricks” section. Your tip just may be selected for publication in The PCLinuxOS Magazine.

This month’s tip comes from PCLinuxOS forum member Not_yet_16.

To set up a temporary, very simple, HTTP server for any directory in your /home directory, follow these instructions.

Open a terminal and `cd` to the directory of choice.

Issue the following command:

```bash
python -m SimpleHTTPServer
```

You can then access the contents of that directory using a browser pointed at the IP address of the PC at port 8000.

**192.168.3.12:8000** as an example, from any PC on the LAN.

You can also access the directory from the same machine (not very useful) using

http://127.0.0.1:8000

or

http://localhost:8000

If the directory has a file named index.html, that file will be served as the initial file. If there is no index.html, then the files in the directory will be listed.

If you wish to change the port that's used, then the command would be:

```bash
python -m SimpleHTTPServer 8888 (or whatever port you chose)
```

I find this really simple and useful at times. Keep it in mind; you might find it equally convenient.

---

**Screenshot Showcase**

![Screenshot of PCLinuxOS](image)

*Posted by Linadian, on June 25, 2016, running Mate.*
Editing Your Vacation Photos With XnViewMP

by Meemaw

So, we have taken PCLinuxOS on vacation, and now we have loads of vacation photos. We can use GIMP to edit them, but sometimes GIMP just has too many choices for us. Don't get me wrong, I love the GIMP program, and use it all the time, but sometimes I just want to crop a photo and resize it, and don't need all the wonderful options that are in the GIMP. This is when I open up XnViewMP and use it. XnViewMP is in the PCLinuxOS repository.

I have used XnViewMP for several years. I even reviewed it in my series on photo viewers and editors, which started in the May, 2011 issue of the magazine. XnView wasn't reviewed until September, but that's because I worked my way up from basic to full-featured viewers.

Now that I am more familiar with it, I can show you a few things I didn't cover in 2011. You can always open a single photo in XnViewMP, simply by right-clicking it and selecting Open With... and choosing XnViewMP. Of course, it is always in your Graphics menu, and you can open it there as well.

One of the things you notice about it is that the window contents are different depending on whether you have a single photo open or if it's the browser. Also, your browser layout may look different from mine because all of that can be edited to your liking. Let's open a single photo first (center, top).

At the top of the window you can see a tab that shows the name of your file. Your program allows you to have multiple photos opened at the same time with tabs that make switching easy. The toolbar is under the tabs area, and it can be configured with items of your choosing. My toolbar has the following icons: Browser, Save, Print, Zoom In, 100%, Zoom Out, Undo, Redo, Show Grid, Previous Image, Next Image, Enhance Colors, Rotate 90° Left, Rotate 90° Right, Crop, Resize, Photo Properties, Quick Slideshow, Fullscreen, Settings and About. All these icons can be rearranged and you can add to the toolbar or take away those items you don't want.

At the bottom of the window is some important information. The first number (36/463) tells what item it is out of the number of items in the folder. All my file browsers are arranged in alphabetical order, so you will want to make sure that it's done the same way here. You can do that in the browser window. Also there is the name of the file, its size, dimensions, print size (I think), your zoom size of the photo and the coordinates of your mouse. At the bottom right is your zoom ratio again, but here you can change it and move the visible part of your photo around if you wish.

Let's do a few editing tasks, though, because that's what we are here to do. Since the normal tasks I use (crop & resize) are in the toolbar, I don't go anywhere else very often, but you will want to get familiar with the Image menu as well. This is where all the editing tools are located. The ones you will probably use the most are Image > Adjust, but you should look at the other submenus anyway, just in case you have the urge to apply a sepia color to a photo for a special effect (by the way, it's under Image > Map).

You'll see that Enhance Colors is in the Image > Adjust menu, but since it is something I do on a regular basis, I added it to my toolbar. Enhance Colors has a lot of the same tools that all other photo editing programs have. You can also see Levels there in the menu, which we have also covered in GIMP. Let's use Enhance Colors first.

My photo is one of a Native American home (hogan) in the Bluff, UT Fort Museum. I think it's a little drab (because it was dark in the house when I snapped the photo). We can brighten this a bit. Choosing Enhance Colors will give you this window (next page, top left):
It seems to put more red into the photo, and -30 seems to put more green. I can see where that might be useful sometimes, but it should probably be used sparingly. If you get different results, since I only tried it on one photo, please let me know.

Cropping and resizing your photos are easy! To resize just select it from the menu, and you'll get a window. Enter the size you desire (or choose one from the preset sizes at the top) and click OK.

You can see that Brightness and Contrast is there, along with Hue, Lightness and Saturation. I changed the Contrast to 15, the Hue to 1, Lightness to -7 and Saturation to 10. Here are before (left) and after (right).

I'm not sure about Temperature but we can try it and see what it does.

If I use the original photo and set the temperature setting to 30, I get the following:

To crop, choose that from the menu (or on the toolbar). An extra line will appear showing dimension boxes and coordinates, along with the Crop button, plus an extra button that says “Save Selection As….”. I like this one as I sometimes want to crop a photo for a certain project, but I don't necessarily want to get rid of the original. This button allows me to save a cropped version in one step while preserving the original.

Wow, there is a lot of information here! This window can be arranged however you want. I like it with the tree at the top left, the thumbnails at the right and a preview at the bottom left, but you can change it however you wish. In this window you will have the tabs at the top showing what's open. The browser always opens in a tab on the left side of the window. There are two toolbars here: one at the top of the window and a separate on above the thumbnails. The top one is as follows (subject to your changes): Full Screen, Print, Rename, Edit IPTC-IIM/XMP, View As..., Sort by..., Thumbnails size, Show files in subfolder, Capture, Export, Batch Convert, Back, Forward, Rotate Counterclockwise, Rotate Clockwise, Layout, Settings and About.

Many of these are self-explanatory, but I'll explain some of them. Full Screen does what it nearly always does: show you your selected image in a full-screen on your monitor. To go back, simply press...
<ESC>. Edit IPTC-1IM/XMP allows you to edit the properties of your selected image. Clicking the icon gives you the following window:

This allows you to add captions or keywords (to help in searches), plus categories and much more.

If you click the arrow to the right of the Sort button, you can see many methods to sort your photos. I always stick with alphabetical by filename, but for other jobs you can sort by file size or type, date taken, category or color (there’s a feature to allow you to assign a rating &/or color label to each photo, but I don’t use it).

Capture is useful as well. Most of PCLOS’s desktops have a screenshot feature, but if you have XnViewMP open, you can do it from right here. The capture window gives you several options. NOTE: You can’t take a screenshot of the XnViewMP window from the XnViewMP program, as it disappears after you pick your options.

Export allows you to save your selected photo in a different format. The window that appears gives you many options for exporting your image.

Batch Convert lets you change a group of photos at the same time. In this window you will have several tabs: Input, Actions, Output, Status and Settings. For Input, you may have already chosen your files before you clicked the Batch Convert button, but you can also drag them to the window. For Actions, you will need to add an action (resize or add a border) and configure that action there. For an action you use repeatedly, you can save it by clicking on the save button at the bottom of the window and giving it a name. In Output, you need to specify if you want to overwrite the original file or whether you want a new, renamed file, and where you want it stored. In Status, you won’t be able to see anything until you have actually done the conversion, and then you will be notified of what was done and if there are any errors. Settings are a few little things that aren’t available in any of the other windows (like background color for any preview panes).

As I said earlier, there is also a toolbar above the thumbnail section which has the following: first line has a location bar which tells you what folder you are in, a favorites button, and a search bar. Under that are forward and backward arrows, and buttons for New Folder, Rename, Delete, Sort, Filter, and View As, which gives you options for how much information to display. You can view only thumbnails, or add the filename, labels or details, or view as icons or a list. The slidebar you see will increase or decrease the size of the thumbnails.

In your settings, you can also configure the information that you see under each photo. Go to Thumbnails (under Browser) and click on the Labels tab. You will see a long list of things you can show under each thumbnail. I generally want to see Filename, File Size, and Height and Width. XnViewMP has programmed a couple of Custom labels, one being Custom 2: (Width)x(Height) and one being Custom 1: {Focal Length}mm f/(F-Number) {Exposure Time}s {ISO Value}iso. You can choose whatever labels you want, and there are a couple of custom labels you can add and program yourself.

You will find many more effects you can apply to your photos. When you have time to “play,” I hope you will test some of these out and see what you can do. Many of the photos we take usually need little more than to be cropped or resized and brightened a bit, but you may find a special effect you want to use. I have used this program for a while, and there is still much I don’t know! As with any program, you learn as you go along, and I hope I have given you a good start on the many features of XnViewMP.
Cheesy Bacon Ranch Potatoes

Ingredients

1 1/2 lb small (two-bite) Yukon gold potatoes, halved
4 teaspoons oil
2 tablespoons ranch dip mix (from 1-oz package)
1 jalapeño chile, seeded, finely chopped
4 slices cooked bacon, coarsely chopped
1 cup shredded Cheddar cheese (4 oz)

Directions

1. Heat gas or charcoal grill. Cut 2 (18x12-inch) sheets of heavy-duty foil. Spray with cooking spray.

2. Add cut potatoes to medium bowl. Drizzle with oil; sprinkle with ranch dip mix. Add jalapeño chile; stir until evenly coated. Place equal amount of mixture on center of each sheet of foil. Evenly sprinkle with bacon.

3. Bring up 2 sides of foil so edges meet. Seal edges, making tight 1/2-inch fold; fold again, allowing space for heat circulation and expansion. Fold other sides to seal.

4. Place packs on grill over medium heat. Cover grill; cook 12 minutes. Rotate packs 1/2 turn; cook 12 to 14 minutes longer or until potatoes are tender.

Remove packs from grill, cut large X across top of each pack. Carefully fold back foil, and sprinkle potatoes with cheese. If desired, garnish with sliced jalapeño chile.

Serves 6

Options:

Regular Yukon gold potatoes can be substituted for the small potatoes in this recipe. Cut them into 3/4-inch chunks.

To make in oven, place packs on cookie sheet. Bake at 375°F 40 to 45 minutes or until potatoes are tender.
**PCLinuxOS Puzzled Partitions**

<table>
<thead>
<tr>
<th></th>
<th>6</th>
<th>5</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

**SUDOKU RULES:** There is only one valid solution to each Sudoku puzzle. The only way the puzzle can be considered solved correctly is when all 81 boxes contain numbers and the other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled for you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no two numbers in the same column of a Sudoku puzzle can be the same. Each row must contain all of the numbers 1 through 9 and no two numbers in the same row of a Sudoku puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no two numbers in the same block of a Sudoku puzzle can be the same.

**SCRAPPLER RULES:**
1. Follow the rules of Scrabble®. You can view them [here](#). You have seven (7) letter tiles with which to make as long a word as you possibly can. Words are based on the English language. Non-English language words are NOT allowed.
2. Red letters are scored double points. Green letters are scored triple points.
3. Add up the score of all the letters that you used. Unused letters are not scored. For red or green letters, apply the multiplier when tallying up your score. Next, apply any additional scoring multipliers, such as double or triple word score.
4. An additional 50 points is added for using all seven (7) of your tiles in a set to make your word. You will not necessarily be able to use all seven (7) of the letters in your set to form a “legal” word.
5. In case you are having difficulty seeing the point value on the letter tiles, here is a list of how they are scored:
   - 0 points: 2 blank tiles
   - 1 point: A, E, I, O, N, R, T, L, S, U
   - 2 points: D, G
   - 3 points: B, C, M, P
   - 4 points: F, H, V, W, Y
   - 5 points: K
   - 8 points: J, X
   - 10 points: Q, Z
6. Optionally, a time limit of 60 minutes should apply to the game, averaging to 12 minutes per letter tile set.
7. Have fun! It's only a game!

Download Puzzle Solutions Here

Possible score 235, average score 164.
PCLinuxOS Crossword Puzzle: July 2016 Rodeo

1. same as a lariat
2. turn it over and tie it's feet
3. same as a lasso
4. the fastest horse and rider
   to run this pattern wins
5. gotta stay on this wild horse
6. need a funny cowboy to distract the bull
7. a cowboy's constant companion...
8. one who "wrangles" or a brand
   of blue jeans
9. control the horse with these
10. cowboys always wear these
11. sometimes you get one when you win
12. dangerous to try to tame a bull
13. many cowboys wear these over their boots
14. goes on the horse's head
15. to sit on

Download Puzzle Solutions Here
Rodeo Word Find

Download Puzzle Solutions Here
More Screenshot Showcase

Posted by OnlyHuman, on June 7, 2016, running e17.

Posted by ruel24, on June 9, 2016, running KDE.

Posted by Tara-Rain-9.58, on June 25, 2016, running Mate.

Posted by tuxlink, on June 4, 2016, running KDE.